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BACKGROUND

The Engineering Financial Services (EFS) Unit is utilizing a structure that tracks Vendor invoices from the
time invoices are received to a system-specific email inbox to the time invoices are paid. The Engineering
Invoice Management System (EIMS), provides streamlining of processes and transparency, as each invoice
is reviewed and signed electronically and advanced under one homogenous workflow. As part of our
commitment for continued improvement, we are pleased to announce an upgrade to the EIMS.

BENEFITS

The new version is designed to improve quality, accuracy and increase invoice turnaround period with the
following new features:

One email account (ENG-Invoices@panynj.gov) for all invoice submission

Multiple invoices per email submission by Vendor

Invoice template for EIMS Phase Il is a readable Smart Form

No conversion of readable Smart Form to PDF required

Auto-generated notifications to Vendors

Validation checks for required cells

Auto font-size reduction for free-form cells to insert extended text

Integration with Agency diversity and Sub-Vendor management platform B2Gnow (a.k.a. B2G)

® NV EWN R

Auto-generated email notifications to Vendors include detailed explanations for the following reasons:

Confirmation of receipt

Declined by EIMS due to failed validation

On-hold for issue resolution and Resumed (previously placed on hold) invoice
Voided by PANYNJ EIMS reviewer

Partial payment

Paid invoice (full payment or partial payment)

ounhkwnNneE

In addition, EIMS auto-declines invoices for the following reasons:

Not in Smart Form format

Not latest standard template

Missing Tax Payer Number

Missing Vendor Name, Vendor Address or Contact

Missing Discipline/Group

Missing PO Number

Missing Agreement Number

Missing Invoice Period Start and/or End date

. Missing Invoice Number

10. Missing Accrual Period and/or Accrual Estimate Value (excludes retro and balance due invoices)
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11. Missing B2G Vendor # for Sub-Vendor who has invoice amount
12. Sub-Vendor # and Name does not match with B2G record

13. Sub-Vendor invoice amount in Pgl does not match with Pg2 charge code breakdown

14. Multiple support documents or support documentation is not in PDF format

15. Duplicate Invoice Number.
An invoice with the same invoice number under the same PO is already in process in EIMS. You
may want to contact the reviewer to void the pervious incorrect invoice in this case.

16. Vendor Name does not match with SAP record.

HOW TO

The Invoice Smart Form requirements and instructions are displayed below:

e Enable macros to ensure Smart Form functions properly

PANYMNJ ENG Invoice Template - v2.0.xlsm [Read-Only] - Excel

Insert  Pagelayot Formulas Data Review View Add-ins ACROB Team  Enterprise Connect  Q Tellme  Tang, Ke P+ Share

insert - | 3 - O

Delete - P~
m Manual

Cell Styles [ Format~ | & - Classification

Alignment Mumber Styles Cells Editing Data Protecti.. = #
able Conten >

B1 r: e 2

A B E | H Il L | N
Vendor Name:| | Vendor Address:
Vendor Contact Name:
Vendor Contact Phone Vendor Contact Email:
Vendor Number:

Taxpayer Number: : For PA use only

The Port Authority of NY & NJ
ATTN: Manager of Financial Performance, ECIP SE Number
|2 Montgomery Street, 4th Floor
|Jersey City, New Jersey 07302
| Email invoices to: ENG-Invoices

Port Authority APM Contact: (as stated in Award Letter)

el
D % Tahoma =T
Emy -

Past B I 1
aste ? =] L uJ

00

Clipboard Font
I SECURITY WARNING Macros have been disabled.

W0 =~ Oy N N =

Ll (=]

J

e Formulas and tabs are locked

e No row, column or tab modifications

e Insert PDF supporting documentation to Smart Form (ONLY ONE PDF allowed per Smart Form;
i.e., timesheets, receipts, Sub-Vendor invoices

Tab 1 — Invoice Field Definitions

List definition of the fields in Invoice form.
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Tab 2 — Pg1 Invoice

INVOICE SMART FORM - VENDOR MANUAL
Engineering Financial Services (EFS)

wendor Mame: Wendar Address:
wendor Contact Wame:
“Wendor Contact Phone “Wendar Contact Email:
wendor Mumber:
The Port Authority of WY & W) SE Mumber

ATTHN: Program Director, EFS

2 Maontgomery Strect, 4th Floor

dersey City, New Jersey 07302

Email invoices to: ENG-laroicez@&paneni.aor
Port Authority APM Contact: (35 stated in Award Letter]

FUEJECT: [as stated in Award Letter]

REFERENCE: EXPERT PROFESSIONAL SERYICES FOR DN A “CALL-IN® BASIE DURING 20____

DisciplinedGroup | £-—-select-—-3 ]
Purchage Order Mumber Invice Mumber
Agreement Mumber Invaice Date

ECI Mumbrer Inveice Period Start
Inwaice Period End

TOTHL WORK CURREHT INFOICE REHAINING
ORDEN EUDGET PREYIOUSLT BILLED AHOUHT EUDGET COHHEHTS

Prime Yendor

Prime Labwaor Cost 0.00 0.00
Prime Qut-of-Pocket Expenses 0.00 0.00
Prime Lump Sum 0.00 0.00
Prime Totals 0.00 0.00 0.00
Sub-Yendors [list below
EZG Yendur 8 Yendur Hamas
0.00 0.00
0.00 0.00
0.00 0.00
0.00 0.00
0.00 0.00
0.00 0.00
0.00 0.00
Add Sk Wunder Zub Totals 000 000 000 000
TOTALS 000 000 0oon 000
Percentage Complete
dActual Total Paid ko Dake
Qutstanding Amount 1) 1le)
Yandur's Accrual Ertimats | A Bosigd Fud | Nember of Days Hamber of
Accrual poerio a (1]
Acerual estimated value
Contract Bemindar £ o sdowt she toontlr M F Sall oF coch month, pou shal rorndor o B or sarwces porfarmed ahd reimbarsadie swt-of pocksl
IR WM e B B Wiy, 3o B Bt PSS SR PO B opuirsat A5 tthe Bragecd Alanager.
Account Code[s]) - §e¢ tab g2 for Account Code Breakdows Sheet

w 1=t BignatoryfTask LeadfDAR nse

Earncd Yalue Analysiz O Pay Pay Partial: Hows Much?

Pay Partial: Reasenf=]

Select lead Discipline/Group from dropdown INt. EIMS reads and directs invoice to appropriate

PANYNJ EIMS end-user to begin workflow

Check Final Invoice if it is the final invoice of the PO
Populate Sub-Vendor cells by adding Sub-Vendor name(s) HERE, not Pg5 Sub-Vendors Expense tab.
The Sub-Vendor with invoice amount requires B2G Vendor #. See next page for where to find B2G
Vendor #.
Add additional rows by clicking the “Add Sub-Vendor” button
Current Invoice Amount data is auto-populated reflecting data in other tabs
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e Remaining Budget is auto populated when the Total Work Order Budget, Previously Billed (if any)
and Current Invoice Amount cells are filled

e Update Accrual Period and Accrual Estimate Values. Accrual Start should be the day after
current invoice period end date; Accrual End should be last day of month in which invoice is
submitted by Vendor; Accrual Estimate should be the estimate billing amount for stated Accrual

Period.

NOTE: B2G Vendor # is unique to each vendor record in B2G. One Vendor could have multiple records in
B2G for different locations/branches/facilities. Make sure you use the B2G Vendor # within the
designated PO (a.k.a. Contract in B2G). Please follow below steps to find this # in B2G.

1. Search PO Number in Search Contracts functions in PA B2G instance.

THE PORT AUTHORITY
OF NY & MNJ

& =)
Home
Yiew »

Search »

Wendors
Certified Vendors

Ls ey
Contracts ,
ns

Outreach Carnpaigns
Proposals
Certification Apps
Search Results »

Reporting »

Search: Contracts

Users  “endors Contracts Concessions  Proposals  Outreach

Search your organization's contract database, Enter information into any of the boxes below and click Search. Some parar

‘ Search ‘ ‘ Clear Form

Search Parameters

COMTRACT/REFEREMCE NUMBER [30()00()2060{

COMTRACT TITLE

CONTAIMING TEXT

2. Access the Contract/PO from search result.
3. Access Subs tab in Contract Management view. The System Vendor Number (8-digit number) can be

found in the View link of each sub-vendor.
mHeporTAUTHORMY  Contract Management: Subcontractor List [ ————

OF NY&NJ

Wain  View Semn:s Change Orders & Task Orders  Alerts Comments Messages  Closeout
& = E]

Compliance Audit List  Compliance Audit Summary  Compliance Audit F¥  Site Visits Reports

Home
. Status: Open
View » Prime GO — Current Award: SR
= Goal: 28.20%  Total Paid: S
S h VRS R % Credit: 13.22% Far Credit: g
earc

Mendors
Certffied Vendars
Users

Contracks
Concessions

Add Subcontractor

R CepEzis Prime Contractor
Froposals
Certfication Apps
Search Results » Vendor Nams Certified Ine. in Goal c“’:::[”‘e Final Pmnt Actions
Reporting » ;
[] ee—hhital DLy - Ho No (] N View Edit More...
Create »
Tools »
Settings » Subcontractors
Help & Support »
Waork Work x Originalf Inc. in  Compliance  Final
Logoff Subcontractor Nama Scope LEE Catesory Certified 13750 Type T s s Actions
hew All Hide All [1] ont— o —  ices, Inc. @  Seaee® cun O @ Nof view ENit More...
IS 100% WEE
[1] oo < S O CIATES, INC. @ jumeid sub © @ Mo\ View Eglt Mare...
" 100% WBE
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3000002060:

Prime: iuhihkiSinkR@eREensm-
1/24/2019 - 12/31/2022

Back to List

INVOICE SMART FORM - VENDOR MANUAL
Engineering Financial Services (EFS)

Stati
Current Award: ¢
Goal: 29.80% Total Paid: ¢
% Credit: 13.22% For Credit:

Vendor Information

PHONE
FAX
EMAIL

ADDRESS

BUSINESS NAME
SYSTEM VENDOR NUMBER

VENDOR COMPLIANCE CONTACT PERSON

B2G Vendor #

New York, NY %@ [map]

If a new sub-vendor needs to be added in B2G, please refer to PANYNJ Diversity Management Program
Intro and Contract Compliance Reporting training and other training material in B2G for PA compliance

and Sub-Vendor management. You can find this training video in B2Gnow under Help & Support -> Video
Library -> Core Training — Staff

< Cc O

‘THE PORT AUTHORITY
OF NY&NJ

e = &
Home
View »
Search »
Reporting »
Create »
Tools »

Settings »

Change Password
Account Security
Your Settings »
Org Settings »
User List

elp 8 Support »

Contact Support
Account SumMmary
User Manual
Other Help Guides
Training Classes

: <

Wideo Library

wish List

Subrnit Fesdhack
Report a Problem
Trust Center

Systern Status Board
Ermail Test

About B2Grow

Logoff

Show Al Hide Al

@ panynj.diversitysoftware.com FrontPage/Diversityh ain.asp?XID= 6455

Select a category:

All Categories v

| New Only

‘ Search ‘

Contract Compliance

Diversity System Overview for CMD

Diversity System Overview for JFK-Red

An overview of how to use the Diversity Management System, including accessing contracts, viewing and tracking monthly payme

An owerew of how to use the Diversity M, System for JFK-Redevelopment
viewing and tracking monthly payment reports, and assessing compliance with goals.

. The session cabers basic systan

Core Training - Staff

Certification Management

Certification - Letter Template

Conwract Compliance
Contract Specific Goal Setting Module

Diversi

Help Desk / Customer Suppo

Introducticn to the System

Qutreach '3

PANYN Diversity Management Program lntro and Contract Compliance Reporting [NEE >
e ——

Power Bl Basics

The Vendor View - What the Vendor Sees

Utilization Plan Management

Farniliarization overview of the certifications management in the Certification Management module,
Familiarization overview of the Certification Management Letter Templates

Managing contract record and tracking contract progress.

How to use the Goal Setting module ta set certified "Far Credit” participation contract gaals,

An advanced review of how to use the Diversity Management System, The session covers basic system functionality, such as confi
as adwanced functions like understanding the Compliance Audit List and Surnmaries.

View and respond ta Vendor Support queries in the B2Gnow system,

Systemn Navigation and Record Management,

How to use the Outreach & Event Management module to outreach campaigns and event management.

Owerview session covering intro to the system, contract compliance, including subcontractor payment reparting and audit process
An intraduction to Power B

“Vendor Wiew" presents in detail what the vendars see when working in the system. Includes major modules and processes.

Learn how and when to assign a Utilization Plan to a prime. Includes review and acceptance of submitted Subcontractor informatic

Core Training - Vendor

Contract Compliance Reporting

Introduction to the System

Online Certification Application

Utilization Plans - Vender

Complets step-by-step instructions for responding to Contract Audits and Discrepancy notices,
System Navigation and Vendar Profile.
How to use the system to submit a paperless online certification application.

Camplete step-by-step instructions far completing and submitting utilization plans.
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Tab 3 — P2 Acct (Account) Code Breakdown

Account Code Breakdown

Invoice Number___ 99855-JohnMain-LT Invoice Date 10/9/2018
PO Number 4900000001 Agreement No. 410-18-001
PRIME Labor Breakdown Operating Program (incl. CG3) m
AMOUNT ($) (c] COST INTERNAL For ECIP
BREAKDOWN * | ACCOUNT CENTER ORDER WBS ELEMENT DESCRIPTION use only
44,000.00 591028 C410A03900000
100.00 591148 410A03 A03901901

ital Account Code for PRIME Labor Add Code
Ahgve Total Aceeefit Code(s) must equal Labor Cost in Pgl Invoice. The Total above will be highlighted in red if it does NOT match.
Operating Program (incl. CG3] m

AMOUNT ($) GL cosT INTERNAL
BREAKDOWN * | ACCOUNT | CENTER ORDER

15,000.00 591148 410A03 A03901901

PRIME Expenses

For ECIP
use only

WBS ELEMENT DESCRIPTION

Jhtal Account Code for PRIME Exp Add Code |
makove Total Aceedi Code(s) must equal Out-of-Pocket Expenses in Pgl Invoice. The Total will be highlighted in red if it does NOT match.

Operating Program (incl. CG3) m

AMOUNT ($) GL COST INTERNAL
BREAKDOWN * | ACCOUNT CENTER ORDER

5,000.00 591148 410A03

SUB-VENDORS

For ECIP
use only

WBS ELEMENT ZuB VENDOR NAMc

tal Account Code for SUB_VENDORS Add Code
Code(s) must equal Sub-Vendor Totals in Pgl Invoice. The Total will be highlighted in red if it does NOT match.

tal Account Code Breakdown*
Breakdown must equal Current Invoice Total. The Total will be highlighted in red if it does NOT mafich.

e Total and each Sub-total Account Code MUST equal to corresponde¢l amounts in Pgl Invoice tab
(highlighted in RED when the total does not match):
1) Account Code total for Prime Labor MUST equal “Prime Labor Cpst” amount
2) Account Code total for Prime Expenses MUST equal “Prime Out{of-Pocket Expenses” amount
3) Account Code total for Prime Lump Sum MUST equal “Prime Lupnp Sum” amount
4) Account Code for each Sub-vendors MUST equal “Sub-Vendors] amount
5) Total Account Code Breakdown MUST equal “Current Invoice Amount” total

e In Sub-Vendors section, select Sub-Vendor Name from dropdown list (list is auto populated from
data entered in Pg1 Invoice tab)

e Add additional rows by clicking the “Add Code” button
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Tab 4 — Pg3 Labor Expense Breakdown

INVOICE SMART FORM - VENDOR MANUAL
Engineering Financial Services (EFS)

APPROVED STAFF NAME
(last name, first name in
alphabetical order)
Smith, John

Labor Expense Breakdown
99855-JohnMain-LT

Invoice Number
Invoice Date
Invoice Period

Multiplier
ONSITE / | Stated in
OFFSITE | Agreement

Off-site 212

10/9/2018

9/1/2018 - 9/30/2018

HOURLY
RATE

$ 55.00

Consultant)

HOURS
WORKED
60.0

WORKED | TOTAL LOADED LABOR

For ECIP
use only
NOT
For PA use only APPROVE
COMMENTS D

20.0 9,328.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

N

0.00

J

Add Staff

Total Labor

60.00

20.00 $9,328.00

Smith, John

Premium Payment for Overtime, Night Work or Hazardous Duty

20.0 500.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

0.00

20.00 $500.00

Mark, Jan

$ 200.00

200.00
0.00
0.00
0.00
0.00

$200.00

e Labor Expense total is auto populated

e Staff eligible for multiplier MUST be listed at the top along with the multiplier stated in the
agreement, regular hours and other hours; i.e., overtime hours

e Premium portion (not subject to multiplier) MUST be listed in the center with premium hourly
rate; i.e., % hourly rate along with overtime hours

e Partners and Principals (not subject to multiplier) MUST be listed at the bottom with customary
billing rate along with number of hours

e Add additional rows by clicking the “Add Staff” button under each category

Page 9 of 16 —Invoice Smart Form— Vendor Manual —v3.1

Total Labor Expense $

10,028.00 ‘

12/01/2022




PORT
AUTHORITY
NY NJ

|

AIR LAND RAIL SEA

INVOICE SMART FORM - VENDOR MANUAL
Engineering Financial Services (EFS)

Tab 5 — Pg4 OOP (Out-of-Pocket) Expense

Out-of-Pocket Expense Breakdown

Invoice Number 99855-JohnMain-LT
Invoice Date 10/9/2018
Invoice Period 9/1/2018 - 9/30/2018
DESCRIPTION OF OUT-OF-POCKET TOTAL OUT-OF-POCKET For PA use only
EXPENSE EXPENSE COMMENTS
Smith, Jane Mileage Office to JFK 35 miles 9/20/2018 11.20
XK Reproduction, Inc. 1,500.00
e~

(‘W 0-0-p BW"Q| Total Qut-of-Pocket Expense| § 1,511.20

v
b | Instruction | PgllInvoice | Pg2 Acct Code Breakdown | Pg3 Labor Expense | Pg4 OOP E>

e QOut-of-Pocket Expense Breakdown total is auto populated in Pgl Invoice tab
o Add additional rows by clicking the “Add O-O-P Expense” button
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Tab 6 — Pg5 Sub-Vendors Expense

Sub-Vendor Expense Breakdown
Invoice Number 99855-JohnMain-LT
Invoice Date 10/9/2018
Invoice Period 9/1/2018 - 9/30/2018
TOTAL SUB-VENDOR For PA use only
SUB-VENDOR NAME SUB-VENDOR INVOICE NUMBER & DATE * EXPENSE COMMENTS
Engineers Corporation Tnv. 123-456 09/14/2018 20,000.00
Enginering, Inc. Inv. A4455 09/10/2018 3,000.00
Lifts & Ladders Pros . 44599 09/20/2018 500.00
Engineers Corporation
Enginering, Inc.
adders Pros ‘
A
g Add Sub-Vendor Expense 2 | Total Sub-Vendor Expense $ 23,500.00
* List eacl Ce seperately \
» | Instruction | Pgl Invoice‘ | Pg2 Acct Code Breakdown | Pg3 Labor Expense | Pg4 OOP Ex

e Sub-Vendor Expense Breakdown to¥al is auto populated in Pgl Invoice tab

e Select Sub-Vendor Name from dropdown list (list is auto populated from data entered in Pgl

Invoice tab)
e List each Sub-Vendor invoice separately
e Add rows by clicking the “Add Sub-Vendor Expense” button
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Tab 7: Pg6 ChangeOrders-Stages (optnl)

(insert project name)
Service Breakdown by Authorization or Stage (Optional)

SUBJECT: (as stated in Award Letter)

REFEREMNCE: EXPERT PROFESSIONAL SERVICES FOR ON A "CALL-IN" BASIS DURING 20__.

WORK ORDER No. x (original authorization) or STAGE No. x

LETTER PREVIOUSLY CURRENT INVOICED TO AWARD LETTER For PA use only
BUDGET BILLED INVOICE AMOUNT DATE BUDGET COMMENTS
Prime Vendor
0.00 0.00
Sub-Vendors (list below'
0.00 0.00
0.00 0.00
0.00 0.00
0.00 0.00
0.00 0.00
0.00 0.00
0.00 0.00
TOTALS 50.00 %0.00 $0.00 $0.00 $0.00

CHANGE ORDER No. xx or STAGE No. xx

LETTER PREYIOUSLY CURRENT INVOICED TO AWARD LETTER For PA use only
BUDGET BILLED INYOICE AMOUNT DATE BUDGET COMMENTS

Prime Vendor
0.00 0.00

Sub-Vendors (list below) | T
0.00 0.00
0.00 0.00
0.00 0.00
0.00 0.00
0.00 0.00
0.00 0.00
0.00 0.00
TOTALS $0.00 $0.00 $0.00 $0.00 $0.00

CHANGE ORDER No. xx or STAGE No. xx

LETTER PREYIOUSLY CURRENT INVOICED TO AWARD LETTER For PA use only
BUDGET BILLED INYOICE AMOUNT DATE BUDGET COMMENTS
Prime Vendor
0.00 0.00
Sub-Vendors (list below’
0.00 0.00
0.00 0.00
0.00 0.00
0.00 0.00
0.00 0.00
0.00 0.00
0.00 0.00
TOTALS 50.00 $0.00 $0.00 $0.00 $0.00

e The Change Orders or Stages tracking tab is OPTIONAL, as required and imparted by the
Agreement Project Manager

e The Sub-Vendors in this list is auto-populated from Pgl Sub-Vendor.
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Tab 8: Support Document — Please read carefully...

Insert Support PDF in balow cell

.| Pgllnvoice | Pg2 Acct Code Breakdown | Pg3 Labor Expense | Pgd OOP Expense | PoS Sub-Vendors Expense | Support Document

e The Smart Form must be submitted in its original format (EXCEL) ONLY
e Asaresult, insert ONE (1) support document in PDF format ONLY into the Smart Form’s “Support
Document” tab; i.e., timesheets, Sub-Vendor invoices, expense receipts, etc.

e Instructions for support document insertion are located in the Smart Form’s last tab labeled
“Support Doc Instruction”

Tab 9 — Support Doc Instruction

Instruction of inserting the PDF support document (one file only) into Excel invoice smart form
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SPECIAL CASE INVOICING PRACTICE

1. When Vendor has multiple staff located at various PANYNJ locations (facilities) AND staff is
approved under a single Purchase Order, Vendor MUST submit multiple monthly invoices per
PANYNJ location (facility). Each monthly invoice is tracked, reviewed and paid individually. The
following requirements apply:

e FEach invoice number MUST incorporate the consultant staff name for whom Vendor is
invoicing and the PANYNJ location (facility acronym); i.e., for Invoice No. 333, staff name John
Smith and facility LaGuardia Airport (LGA), use Invoice No. “333-JohnSmith-LGA” — (no spaces)

e PANYNIJ facility acronym MUST be selected from the drop-down list located in Pgl Invoice tab

SUBJECT: LGA Runway Lighting

REFERENCE: EXPERT PROFESSIONAL SERVICES FOR MALL*IN" BASIS DURING 2017.

Discipline/Group[410 - LGA (LaGuardia Airport) <+ |
Purchase Order Number 4999999955 Inveice Number  333-JohnSmith-LGA
Agreement Number 410-17-000 Invoice Date 7/15/2018
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2. When Vendor has a single staff located at various PANYNIJ locations (facilities) AND staff is
approved under a single Purchase Order, Vendor may CHOOSE ONE of the following two options:

a) Submit multiple monthly invoices, one per PANYNJ location (facility)
NOTE: This method offers quicker invoice turnaroufid, as each invoice is reviewed by
fewer PANYNJ EIMS end-users

SUBJECT: JFK Reafing

REFERENCE: EXPERT PROFESSIONAL SERVI(% UN’\ "CALL-IN™ BASIS DURING 2017.

Distipline.-'Gmup|4w - JFK (John F. Kenneady Iﬁmaﬂnnal *rport'l -

Purchase Crder Mumber 45999999555 Invoice Mumier  556-5-JohnMain-JFK
Agresment Number 410-17-000 Invoice Cfte 71572018

SUBJECT: LT Lighing Replacemeant

REFERENCE: EXPERT PROFESSIONAL SERVICES FO A "CALL-IN™ BASIS DURING 2017.

Ciscipline/Graup 410 - LT (Lincoln Tunnel) o
Purchase Order Mumber 49559999955 Invoice Mumber  9%8-5-JohnMain-LT
Agrezment Mumber 410-17-000 Irwoice Dabe 715,018

- - — I ——

b) Select “Other” from the dropdown list in Pg1 Invoice tab AND use Pg3 Labor Expense tab to
list the indiviNual staff name and facility.

SUHIECT: L&A Runwany Li

Discipline/Graup|410 - Othe B

Purchase Order Mumber AG555R9500 Invoice Mumber 154
Agresment Mumber 410-1§-000 Irvgics Dabe 7f15/2018

Labor Expense Breakdown

Invoice Number 123
Invoice Date 7/15/2018
Invoice Period  6/1/2018 - 6/30/2018

PA CONSULTANT
APPROVED STAFF NAM 11] APPROVED OTHER For FA use
(last name, first name n ONSITE [ |(A|lply to On-site| HOURLY REG. HOURS HOURS | TOTAL LABOR only

alphabetical ordv ) OFFSITE Consultant) RATE WORKED WORKED | EXPENSE COMMENTS

Smith, Jane (EWR) : 5 50.00 100.0 10.0 5,500.,00
Smith, John (HT} On-site 5 50.00 100.0 10.0 5,500.00
0.00

0.00

0.00

fuddl Stall | Total Labor Expense 200.00 20.00 £11,000.00

Times Mudtiplier Stated in
Agreement 2.12345

Sub-Total with Multiplier $23,357.95

Premium Pa for Overtime, Night Work or Hazardous Dul
Semith, Jane (EWR) On-site $ 2SO0 R 10.0 250.00
smith, John (HT) On-site $ 2500 0 10.0 250.00

i nnn
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3. Forthe balance due on a previously disallowed invoice, Vendor MUST submit an invoice using the
same (original) invoice number with the suffix “BALANCE” and a number reflecting if the invoice
balance is being submitted for the first or second time. For example, for original Invoice No. 2088,
use Invoice No. “2088BALANCE1”. The “Vendor’s estimate for next month’s invoice” should be
“zero.”

4. For a retroactive amount due, Vendor MUST submit an invoice using a new (original) invoice
number with the suffix “RETRO”. For example, for Invoice No. 22556, use Invoice No.
“22556RETRQO”. The “Vendor’s estimate for next month’s invoice” should be “zero.”

5. For bills in accordance with a PANYNJ Audit Department report, Vendor MUST submit an invoice
using a new (original) invoice number with the suffix “AUDIT”. For example, for Invoice No. 68997,
use Invoice No. “68997AUDIT”. The “Vendor’s estimate for next month’s invoice” should be “zero.”

6. For a final invoice in a Purchase Order, Vendor MUST submit an invoice using a new (original)
invoice number and flag the “Final Invoice” indicator located to the right of the “Invoice Number”
field. The “Vendor’s estimate for next month’s invoice” should be “zero.”

GENERAL VENDOR INVOICING REQUIREMENTS

o Vendor must bill on or about the 15th of each month for services performed and reimbursable
out-of-pocket expenses incurred in the prior month

e Invoice must display Vendor's taxpayer and purchase order number (the PANYNJ issued Vendor
number is also required by the Comptroller’s Department)

e Vendor and Sub-Vendor must keep daily records of time spent, salaries and amounts actually paid
for the performance of services

e Vendor and Sub-Vendor must keep records and receipts of reimbursable expenditures incurred for
the performance of services

For questions or concerns regarding Vendor invoices, please contact one of the following EFS staff:

e For Engineering and Architectural Design Division (Unit 415), Principal Customer Service Manager,
Amy DeNardo at ADeNardo@panynj.gov or 201-395-3627

e For all OTHER Engineering Department divisions (including Sandy Projects), Principal Customer
Service Manager, Stacey Gibson Williams at StGibson@panynj.gov or 201-395-3651

e Elia Zedefio, Program Director of Financial Performance at EZedeno@panynj.gov or 201-395-3674
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